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Disclaimers 
 

• The content of this manual is subject to change without prior notice. 

• The reproduction or transfer of this manual in any form whatsoever is prohibited without the prior written 

permission of the Noise Laboratory Co., Ltd. (NoiseKen). 

• Although every effort has been made to ensure that the content of this manual is accurate and complete, 

please contact NoiseKen if you find any unclear points, errors, omissions, or other inconsistencies. 

• NoiseKen will not be liable for any damages that occur due to improper usage of this product by the 

customer, failure to follow the information in this manual, or repair or modifications performed by a third 

party other than NoiseKen or a party designated by NoiseKen. 

• Regardless of the above, NoiseKen will not be liable for any test results obtained using this product or for its 

effects on the tested equipment. 

• The trademarks and company names appearing in this manual are trademarks or registered trademarks of 

their respective companies. In this manual, the trademark symbol (TM) and registered symbol (R) are 

omitted. 

• Security Export Control System: Requirements for Exporting This NoiseKen Product 

Although this product does not come under rows 1 to 15 of Appended Table 1 of the Export Trade Control 

Order, it comes under the restricted goods catch-all in row 16. For this reason, you must submit an export 

declaration to NoiseKen before exporting this product outside Japan or temporarily taking it outside Japan 

to enable us to conduct a confirmation screening of the final customer, final application, and other details. In 

the provided information, the customer will be requested to confirm that the final destination country, final 

customer, final application, and other details in the export declaration comply with the restrictions in row 16 

of Appended Table 1 of the Export Trade Control Order. 

 

To ensure strict compliance with export control laws, submission of an export declaration is required. Also, 

when reselling the product at a location inside or outside Japan, the repurchaser must also be notified of 

above information. 

 
* Because the above information is based on laws and regulations, it is subject to change due to revisions in the 

applicable laws and regulations. For details on the control and export procedures in laws and regulations, please 

contact the applicable government agency (such as the Ministry of Economy, Trade and Industry; Trade and 

Economic Cooperation Bureau; Trade Control Department; Security Export Control Policy Division). 
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1. Software Licensing Terms 
 

1. Usage Limitations 
Please use the Software for the purposes described in the instruction manuals or the 
specifications. Do not use the Software for purposes other than these. 

 

2. Intended Users 
Please ensure that individuals who use the Software have received the appropriate training and 
practice with regard to the entire system in which the Software runs, including the usage 
environment, equipment safety, and operating methods. 

 

3. Ability to Make Copies 
The Software may be installed and used on multiple personal computers by individuals who are 
members of the business location (factory, branch office, business office, etc.) that purchased the 
Software. 

 

4. Handling of Intellectual Property Rights 
The Software and the intellectual property rights including copyrights for the Software belong to 
NoiseKen. 

 

5. Usage Period 
The usage period designated by NoiseKen shall take effect when the installation of the Software 
or the prescribed procedure for use, whichever is later, has been completed by the Customer, and 
the Customer's right to use the Software shall be deemed to have expired at the end of this usage 
period. 

 

6. Usage Termination Conditions 
If the Customer has violated any of the provisions in this document, or has infringed on the 
copyrights or other intellectual property rights of NoiseKen, NoiseKen shall have the ability to 
revoke the Customer's license to use the Software. 

 

7. Procedures Upon Usage Termination 
The Customer shall promptly uninstall the Software. (If other instructions have been issued by 
NoiseKen, these shall be followed by the Customer.) 

 
8. Disclaimer 

NoiseKen and its dealers and affiliates will not be liable for any customer damages arising from the 
use of this software or for claims of damages by third parties against customers except in the case 
of intentional or gross negligence by NoiseKen, its dealer, or affiliates. 

 
9. Prohibitions 

The following actions are prohibited with regard to the Software. 
(1) Modifications, additions, and other alterations to the functionality of the Software 
(2) Any form of reverse engineering, including decompilation and disassembly, of the Software 
(3) Reselling, transferring, redistributing, licensing, etc. of the Software, or the accessories 

provided by NoiseKen for the Software, to third parties 
(4) Storing the Software, or the information, documentation, and the like provided by NoiseKen for 

the Software, on a network in a state wherein it may be conveyed to a third party 
 
10. Handling of USB and other protection keys 

The software provided by NoiseKen may require USB or other protection keys. 
(1) If a protection key is included in the accessories, the protection key must be mounted in the 

computer where the software is used. 
(2) As a general rule, the protection key is not reissued. In the event that the protection key is 

damaged or lost, please contact the NoiseKen Sales (or Repair) Division. 
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2. IMPORTANT SAFETY PRECAUTIONS 
 
This software performs visualization of magnetic field emissions in space. Important information for 
safe operation when performing visualization using this software is provided below, and so be sure to 
read it carefully before use. 
Also, be sure to carefully read this manual and the instruction manual for each device to be used 
before using this software. 
 

1. Incorrect or careless operation could result in a fatal injury. 

2. Avoid use in locations exposed to high humidity and large amounts of dust. 

3. When making connections, electric shock can occur due to contact with the supply 

voltage, and so before performing any connection work, be sure to turn off the power 

to the each device, and check that no power is flowing. 

4. Do not turn off the power to the each device or disconnect any cables while this 

software is running. This could cause PC operation to become unstable or the OS to 

malfunction. Be sure to always exit this software before turning off the power to the 

each device.
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3. Item Check List 
 

Before starting use, check that the parts and accessories below are 
included with the product. 

 

A B C 

 

 
 

D E F 

  

 
G H I J 

 

  

 
 
 A: Web camera 

・ Main part ······························································ 1 
・ Warranty ······························································ 1 

 B: LAN cable (2 m) ····························································· 1 
 C: USB extension cable (2 m) ··············································· 1 
 D: Setup media (EPS-02EMFv2 / EPS-02Hv2) ························· 1 
 E: USB protect key ····························································· 1 
 F: Camera tripod 

・ Main part ······························································ 1 
・ Storage bag ·························································· 1 

 G: Extension pole ······························································· 1 
 H: Japanese Quick Start Guide ············································· 1 
 I: English Quick Start Guide ·················································· 1 
 J: Storage case ·································································· 1 
 
* The key of A, D, H and I are included in the upgrade version, and the key of D is disk media. 
* The key of D, E, H and I are included in the secondary license version, and the key of D is disk 
media. 
* If the software version at the time of purchase is earlier than Ver.1.0.3.0, refer to the instruction 
manual at the time of purchase. 
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4. Introduction 
 

Thank you for purchasing the EPS-02EMFv2 Space-Magnetic Field Visualization System. 

Before using the EPS-02EMFv2, be sure to carefully read this manual to ensure that you 

maximize its performance when operating the EPS-02EMFv2. 

 

 This User Guide is provided to ensure that people who follow the operating procedures 

and safety information can safely use the EPS-02EMFv2 and maximize its performance. 

 Place this User Guide in a location where it is easily accessible whenever operating the 

EPS-02EMFv2. 

 

4－1. Features 

 
Enabling visualization of magnetic field emissions in space 

 With the FT3470-91 magnetic field measuring instrument by Hioki as a measurement sensor, 

high-speed FFT processing of the supported oscilloscope by Rohde & Schwarz is used to 

perform frequency analysis of the magnetic field for mapping to the emission location of the 

actual image. 

 The emission location is mapped relative to the sensor location recognized using the web 

camera. 

 An area of up to 64 blocks × 48 blocks can be measured. 

 A superimposed image of the measurement strength distribution diagram and web camera 

image are displayed for enabling easy identification of the emission source. The density of 

the strength distribution and frequency range can be specified. 

 Measured results can be saved to a file, and the content of the measurement results and 

saved file can be compared for enabling visualization of the effects of corrective actions. 

 Measurement sensor location detection by hand instead of using a positioner is possible for 

enabling easy measurement in cramped spaces, outdoors, and other difficult-to-access 

locations. 
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6. Overview 
 

6－1. Notation Used in This Guide 

 
The marks used in this guide and their meanings are provided below. 

 Provides an additional explanation. 

 Indicates a location for further reference. 

 Indicates a setting restriction. 

 Indicates that you must check before usage. 

【 】 Indicates information inscribed on the panel of this testing device. 

 

6－2. EPS-02EMFv2 Features 

 

＊ Measurement sensor is detected from the image for recognizing the measurement 
location 
The measurement object and measurement sensor are captured by a camera, and the 
measurement sensor is found within the image for identifying the measurement location. The 
recognized measurement location is a relative location within the camera image. 
Any user-selected color can be specified for the measurement sensor. However, selecting a 
color with the same tone as the background color will result in a reduced rate of recognition 
and even mistaken recognition in certain cases. 
The measurable range is the area shown in the camera, but it is restricted to a range that can 
be recognized by the measurement sensor. 
 

＊ Automatic control by software 
Measurement sensor recognition from the camera image and oscilloscope control are 
performed automatically. The measurement results can be output as a CSV file, and the 
image can be output in BMP format. 
Also, because the software is a Microsoft Windows application, it provides an 
easily-accessible interface that uses mouse operations while viewing the screen. 
 

＊ Visual display of measurement results 
The measurement strength distribution and camera image are displayed as a superimposed 
image on the computer screen. Also, the mouse pointer in the image can be used to confirm 
measurement results for any selected position. 
In addition, an interpolation view of the surrounding strength can be used to provide easier 
assessment of the generation points. 
 

＊ Full emission analysis function for measurement points 
Data can be collected for the entire measurement frequency range generated from the 
measured object in a single measurement. The emission map for each frequency band is 
also redisplayed by simply specifying the frequency band. 
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6－3. Measurement Principle 

 
The EPS-02 system performs two main operations for enabling visualization of the electromagnetic 

field. First, it performs image recognition that identifies the measurement sensor location from the 

recording image. Second, it provides a color-coded distribution on the image indicating the strength of 

the signals detected by the measurement sensor. 

In image recognition, 640 x 480 pixel video from the camera is monitored in real time, and a 

specific color only is extracted based on the specified parameters for "hue", "brightness", and 

"saturation". By finding the focal point of the area with the specific color, the location of the specific 

object (measurement sensor) can be found in the image. 

If an object with the same color as the specified color, but that is not the measurement sensor, 

appears in the image, the measurement sensor location cannot be recognized correctly because the 

focal point of all objects of this color is calculated. Therefore, the parameter settings for "hue", 

"brightness", and "saturation" that are used to detect the measurement sensor, the brightness and 

light exposure in the recording location, and selection of the lighting are important factors. Depending 

on the color of the measurement object, in certain cases, measurement sensor covers that are 

provided as standard for magnetic field measuring instruments cannot be used. 

The magnetic field strength is measured using a configuration with the FT-3470-91 magnetic field 

measuring instrument by Hioki, which is compliant with the IEC-62233:2005 (JIS TS C0044:2010) 

standards for protecting from human exposure due to household appliances. The magnetic field 

sensor consists of 100 cm2 loop coils combined as the X, Y, and Z rectangular coordinates for 

capturing the magnetic flux of the respective field. (This magnetic field sensor is a specially-order 

model for this system, and other models may not work correctly in this system.) 

Magnetic field measurement has two modes. 

EPS-02Hv2 Processing 

The FT3470-91 is connected to the PC by a USB cable. This connection is used by the FT-3470-91 

to output 10 Hz to 400 kHz magnetic field strength data at four times per second. This strength is 

superimposed on the PC image for creating a magnetic field strength distribution diagram. If data 

arrives at the same image location, it is overwritten or written by Max Hold. 

The magnetic field data can be displayed by selecting the units of magnetic flux density T (tesla) or 

G (gauss), or magnetic field strength A/m (ampere per meter) in magnetic field strength mode. In 

human exposure mode, the limit value can be displayed as a percentage (%) based on the reference 

level for general public exposure and reference level for occupational exposure specified in the 

ICNIRP Guidelines* for 2010.  

In this case, the total amount of the magnetic field for the X, Y, and Z axes for 10 Hz to 400 kHz is 

combined and displayed, and no information about the frequency is provided. 
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EPS-02EMFv2 Processing 

The analog output for the X-Y-Z magnetic fields of the FT-3470-91 is connected to the supported 

oscilloscope by Rohde & Schwarz. (Disconnect the USB cable of the magnetic field sensor.) The 

FT3470-91 magnetic field sensor is set to magnetic flux density mode. 

The realtime signals of the three axes detected by the magnetic field sensor are connected to the 

respective channels of the oscilloscope, frequency analysis (FFT) processing is performed 

simultaneously with waveform input, the frequency spectrum of each axis is imported to the PC using 

real time processing at 4 times per second, and this is saved as position data identified by image 

recognition. Data acquired at the same position is overwritten or written by max hold. 

After measurement is completed, the frequency range that you want to view can be selected for 

creating a strength distribution combined with the image. 

 

 

*ICNIRP Guidelines 

These are guidelines provided by the International Commission on Non-Ionizing Radiation 

Protection (ICNIRP), and they are available in a 1998 version and 2010 version. Most of the 

current restrictions and standards for human health protection are based on these guidelines. 

These guidelines are available for download free of charge from the websites below. 

http://www.icnirp.de/                      ICNIRP website 

http://www.jeic-emf.jp/social/icnipr.html     Japan EMF Information Center website 
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7. System Configuration Diagram 
 

7－1. System Configuration Diagram 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

① Web camera 

This displays the measurement object. 

② Control PC 

This is used to control various devices and perform magnetic field frequency measurement. 

③ Oscilloscope 

The RTO2004-NSL or RTO6 oscilloscope by Rohde & Schwarz is used. The RTO2004-NSL was 

specially adjusted for this system, and so its specifications are different from the typical product. 

For details, please contact NoiseKen or Rohde & Schwarz Japan. 

④ Magnetic field measuring instrument and measurement sensor 

The FT3470-91 magnetic field measuring instrument and FT3471-91 measurement sensor by 

Hioki are used. The magnetic field measuring instrument was specially adjusted for this system, 

and so its specifications are different from the typical product. For details, please contact 

NoiseKen or Hioki. 

 

①  ② 

③ 
④ 

USB cable 

 

LAN cable 
 

Analog signals 
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7－2. Functions of Each Device 

 

① Web camera 

This is a general-purpose web camera. The measurement object is displayed and transferred to 

the PC. The web camera is connected to the PC by a USB cable. If necessary, the connection 

can be extended by a USB extension cable. 

② Control PC 

This enables running of system control software. This software imports images from the web 

camera, identifies the measurement sensor within the image, and finds its location. Measurement 

results that have undergone high-speed FFT processing are received from the oscilloscope and 

mapped to the location. 

③ Oscilloscope 

This is the supported oscilloscope by Rohde & Schwarz. This performs high-speed FFT 

processing of the waveforms of the X, Y, and Z axes sent from the measuring instrument. 

The oscilloscope is connected to the PC using the supplied LAN cable. 

④ Magnetic field measuring instrument and measurement sensor 

This is the FT3470-91 magnetic field measuring instrument and FT3471-91 measurement sensor 

by Hioki. These are used to measure the magnetic field component emitted from the 

measurement object. The waveform outputs for the X, Y, and Z axes in the measurement results 

are transferred to the oscilloscope using an output cable. 

To increase the recognition rate, a special cover provided with the magnetic field measuring 

instrument is attached to the sensor. 

A 5-meter sensor extension cable is also included for easier measurement. The measurement 

path including the extension cable was calibrated at factory shipping. 
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8. Preparation 
 
 

CAUTION 
Environments having poor signal reception 
In environments exposed to extremely large amounts of external noise, the equipment may be unable 
to realize its maximum performance. 
Even when indoors, the equipment can be affected by lighting and other electronic devices. During 
measurement, try to minimize the effect of the electromagnetic environment to prevent external noise 
from affecting the equipment. Also, certain PCs may generate large amounts of noise emissions and 
may not be suitable for measurement systems. 

 
 

8－1. System Backup 

 
NoiseKen provides an optional service (additional charges apply) for installing the EPS-02EMFv2 
program in your PC before providing the program, but if the program is erased, install it from the 
supplied setup media. The installation procedure is included in the "Readme.txt" file. Copy the 
content of the setup media to a hard disk, removable disk, or other location and store it there in case 
of loss. 
For details of setup, see "10.Setup" (P34). 

8－2. Magnetic Field Measuring Instrument Settings 

 

① A sphere-shaped cover for improving the rate of recognition is attached to the measurement 
sensor section. When attaching the cover, align the sensor X/Y/Z with the cover X/Y/Z. The 
measurement sensor and measuring instrument are connected by the extension cable included 
with the measuring instrument. 
 

② Press the "POWER/BATT" button on the magnetic field measuring instrument to turn on the 
instrument power. The instrument startup process takes several seconds. 
 

③ Check that the magnetic field measuring instrument is started, press the OUTPUT button, and 
check that "MON" appears on the measuring instrument screen. 
 

 
This operation is necessary whenever turning on the magnetic field measuring instrument. 

 

④ To turn off the power for the magnetic field measuring instrument, hold down the 
"POWER/BATT" button for about two seconds. 
 

⑤ For further details, see the instruction manual for the magnetic field measuring instrument. 
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8－3. System Connections 

 

① Connect the web camera to the PC using the USB cable. Any commercially-available USB cable 
can be used, but it must be a cable that supports the USB 2.0 standards. Be aware that the USB 
2.0 standards limit the cables to a maximum of 1 extension and maximum length of 5 m. 
 

② The oscilloscope and PC are connected by a LAN cable. A commercially-available cable can be 
used for the LAN cable. Use a one-to-one local connection without passing through the site LAN 
or hub. 
 

③ The magnetic field sensor and magnetic field measuring instrument are connected by the 9758 
extension cable included with the magnetic field measuring instrument. The magnetic field 
measuring instrument and oscilloscope are connected by the 9759 output cable. 
In this configuration, never connect the magnetic field measuring instrument and PC using a USB 
cable. This could result in damage to the instruments. 

 
 

 
Do not connect magnetic field measuring instruments to an oscilloscope (BNC) and PC (USB) 
at the same time. 
Doing so could damage the instrument. 
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Screen displayed immediately after the software is started 
 

9. Usage Procedure 
 

9－1. Starting and Exiting the Software 

 

Starting the Software 
To start the software, double-click the EPS-02EMFv2 shortcut icon on the desktop. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exiting the Software 
To exit the software, click the close button on the right end of the title bar or click Exit from the File 

menu. 

Because the software cannot be closed during measurement, finish measurement before exiting the 

software. 

Click 
Click 

Double-click 
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Image Recognition Setting dialog box 
 

  

9－2. Image Recognition Settings 

 

Image Recognition Setting Dialog Box 
To open the Image Recognition Setting dialog box, click Image Recognition Setting from the 

Set menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Adjust the camera position so that the measurement object can be captured by the camera. 
Take the following conditions into account during adjustment. Changing camera properties or 
adjusting the lighting may be required depending on the circumstances. 

 ・Sufficient brightness is provided so that the measurement object and the measurement    

sensor can be fully recognized. 

 ・There is no object whose color is similar to that of the measurement sensor. 

 

Device Name 
Camera names are displayed in the Device Name list. If multiple cameras are connected, select 

the camera to be used from the device name list. 

 

 

 

Click 

Select a camera 
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Video Proc Amp screen Camera Control screen 

  

Device Filters 
To open the Webcam Properties dialog box, click the Device Filters button. 

In the dialog box, the camera properties, such as zoom, white balance, and anti-flicker, can be set. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 White balance 

White balance is a function to perform color correction so that a white object appears white. If the 

light source, such as sunlight, light bulb, or fluorescent, makes the white object look bluish or 

reddish, adjust white balance. 

 Anti Flicker 

Anti Flicker is a function to reduce flicker in images. 

 Zoom 

Zooming may not be possible depending on the model, driver, or color space / compression 

settings. Refer to “Other Settings” on page 17 for the color space / compression. 

 

 
The Properties screen may vary depending on the model or driver version of the connected 
camera. 

Click 

Zoom 

Anti Flicker 

White balance 
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Other Settings dialog box 

  

Other Settings 
To open the Other Settings dialog box, click the Other Settings button. 

In the dialog box, the color space / compression and camera processing can be set. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Color Space / Compression 

The color space / compression of the camera can be changed. If the camera is not working 

properly, changing it may improve the situation. The first item in the list is the recommended 

method. 

(2) High speed processing 

Speed up camera processing. If the camera is not working properly, unchecking the checkbox 

may improve the situation. 

  

Click 

(1) 

(2) 
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Image Recognition Setting 
Adjust the three parameters, Hue, Saturation, and Value, in the Image Processing Setting so 

that the color of the magnetic sensor can be recognized. The binarized image on the right side can 

be changed by moving the slider of each parameter. 

Hue: Sets the hue, such as red, blue, or yellow 

Saturation: Sets the intensity and purity of a hue 

Value: Sets the lightness of a color. 

 

 

 

 

 

Adjust the parameters until the magnetic field measurement sensor is recognized as a circle and 

no other object is recognized. If there is any object whose color is similar to that of the sensor in the 

background, hide the object or change the color of the sensor. 

Once the sensor is recognized as a circle, click OK to complete adjustment. 

 

 

 

 

 

 

 

 

 

 

 

 
Procedure for successful sensor recognition setting 

1. Set the Saturation and Value to 0. 
2. Adjust the Hue so that the sensor is most clearly recognized. 
3. Increase the Saturation gradually to remove other recognized areas around the sensor. 

Do not increase the Saturation excessively to prevent the recognized sensor area from 
being impaired. 

4. Increase the Value in the same manner. 
5. Finally, move the sensor outside of the camera view, and make sure that there is no 

object to be recognized.  
If any other object is recognized, repeat steps 3 and 4. 
When the mal-recognition is not solved even if steps 3 and 4 are repeated, start over 
from step 1. 

Desirable recognition state 
The shape of the sensor is almost circular. 
There are no recognized areas in the 
background. 
 

Not desirable recognition state 
The shape of the sensor is not circular. 
There are recognized areas in the 
background. 
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Communication Settings dialog 
 

  

9－3. Communication Settings 

 

Communication Settings Dialog Box 
To open the Communication Settings dialog box, click Communication Settings from the Set 

menu. 

In this dialog box, a remote-controlled oscilloscope can be set up. 

 

 

 

 

 

 

 

 

 

Equipment Name 
Select the equipment name of the connected oscilloscope. 

The RTO2004-NSL or RTO6 is available. 

 

 

 

 
When NI-VISA (National Instruments) has not been installed, the Equipment Name list is blank 

even if oscilloscope drivers exist. In such cases, install NI-VISA according to “10－3.Installing the 

Software” in page 35 

  

Interface 
Selectable interface types vary depending on the selected equipment. 

Only LAN is available. 

 

 

IP Address 
Set the IP address. 

For how to set the IP address, see “10－2.Network Address Settings” in page 34. 

 

 

Click 



9.Usage Procedure 

 20 

View window (before measurement) 
 

  

9－4. New Measurement (Setting Measurement Conditions) 

 

View Window 
To open a View window, click New Measurement from the File menu or click the New 

Measurement button on the toolbar. 

Whenever a View window is newly opened, it is numbered as follows: View1, View2, View3 ... 

These names can be changed freely when the file is saved after measurement. 

Before starting measurement, set an image division size, properties for the oscilloscope, and other 

conditions in the View window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
If a web camera or USB protect key is not connected, new measurement is not possible. 

 

Click 

Click 
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Conditions (before measurement) 
 

Conditions (after measurement) 
 

Image division size: 10 pixels 
 

Image division size: 160 pixels 
 

  

Condition Tab 
In the Condition tab, set the image division size, properties for the oscilloscope, and other 

conditions. 

Condition items can be set only before measurement. After completion of measurement, all items 

are displayed but cannot be changed. 

 

 

 

 

 

 

 

 

 

 

 

 

Image Division Size 
Set the division size by which a camera image of 640 × 480 pixels is divided. 

The image division size can be selected from 10 pixels (H: 64 × V: 48 squares), 16 pixels (H: 40 × 

V: 30 squares), 20 pixels (H: 32 × V: 24 squares), 32 pixels (H: 20 × V: 15 squares), 40 pixels (H: 

16 × V: 12 squares), 80 pixels (H: 8 × V: 6 squares), or 160 pixels (H: 4 × V: 3 squares). 

Select 20 or 32 pixels normally. 

 

 

 

 

 

 

 

 

 



9.Usage Procedure 

 22 

  

Capturing 
How to store spectrum data at the same measurement point (the same square of the grid) can be 

selected from SINGLE, FREE RUN, or PEAK HOLD. 

SINGLE: done only one time 

FREE RUN: overwritten and the latest data is retained 

PEAK HOLD: overwritten and the spectrum with the maximum value (intensity) is retained 

 

 

 

 

Frequency 
The measurement frequency range is 10 Hz (0.01 kHz) to 400 kHz. 

The unit is fixed at kilo Hz.  

 

 

 

 

Oscilloscope 
The model number of the connected oscilloscope is shown. 

For scope settings, refer to [9－3.Communication Settings] on page 19. 
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Before measurement 
 

During measurement 
 

After measurement 
 

  

9－5. New Measurement (Performing Measurement) 

 

Performing Measurement 
To start measurement, click the START button in the upper right of the View window. During 

measurement, the PAUSE and STOP buttons are enabled. 

To suspend measurement, click the PAUSE button to suspend measurement, and to finish 

measurement, the STOP button. 

After completion of measurement, all buttons are disabled. When performing measurement again, 

click New Measurement from the File menu or click the New Measurement button on the toolbar. 

 

 

 

 

Once measurement is started, the Map View and Comment tabs appear next to the Condition tab. 

In the Map View tab, only Transmittance can be changed during measurement, and all items can 

be set after completion of measurement. Items in the Comment tab can be set even during 

measurement. 

Points (squares of the grid) that have been measured are color-coded according to the peak value 

and overlaid on the camera image during measurement. In addition, the spectrum data measured 

by the oscilloscope is displayed in the spectrum graph area located in the lower part of the View 

window, on a point-by-point basis. 

 

 

 

 

 

 

 

 

 

 

 

 

 
Move the measurement sensor while keeping the same direction and maintaining a constant 
distance from the object to be measured. 
Also, align X/Y/Z of the measurement sensor with the vertical and horizontal axes.  

START 
PAUSE STOP 
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Before deleting data 
 

After deleting data 
 

  

The EPS-02EMFv2 software sends a command for acquisition of the spectrum graph to the scope 

immediately after the sensor is recognized. After completion of acquisition, the software recognizes 

the sensor position again, and only when the sensor is found at the same point (position) where it 

was placed at the start of acquisition, the spectrum data is stored.  

If the sensor is moved quickly, the point at the start of acquisition differs from that at the completion 

of acquisition, and as a result, measurement data is not stored. When spectrum graphs are not 

obtained smoothly, move the sensor more slowly or set to a larger image division size. 

 

If the sensor is not recognized or other object is falsely recognized, reconfigure the image 

recognition setting. Click Image Recognition Setting from the Set menu to change the setting. 

Please note that it is possible during measurement. 

 

Deleting Measurement Data 
Stored measurement data can be deleted on a point-by-point basis. 

When data to be deleted is right-clicked during measurement, the Delete menu will appear. Click 

this menu to delete the measurement data for the corresponding point. 

 

 

 

 

 

 

 

 

 

 

 

 
Data can be deleted only during measurement and cannot be deleted after completion of 
measurement. 
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Before recapturing 
 

After recapturing 
 

  

Recapturing Camera Image 
If the STOP button is clicked after completion of measurement, the camera image switches from 

video to still image. If the still camera image includes an unnecessary object, such as the sensor, 

the camera image can be recaptured. 

Click Recapture Camera Image from the Window menu. The still image will switch to video and 

the following message will be displayed. 

 

 

 

 

 

 

 

Clicking the OK button switches the camera image from video to still image to capture a new 

camera image. To return the original camera image, click the Cancel button. 

 

 

 

 

 

 

 

 

 

 

 
Recapturing is possible as many times as needed before the file is saved. 
Note that recapturing is not possible once the file is saved. 

Click 
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Condition tab 
 

Map View tab 
 

Comment tab 
 

  

9－6. Measurement Data Analysis 

 

Measurement Data 
After completion of measurement, a square pointer    will be displayed on the camera image. 

Dragging this pointer to the desired point can display the spectrum data at the relevant point. 

The pointer automatically moves to the highest level point immediately after measurement is 

complete or the file is opened. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Condition tab, the conditions configured before measurement can be checked. The 

representation of measurement data can be changed in the Map View tab. In the Comment tab, 

measurement information and other comments can be entered. 

 

 

 

 

 

 

 

 

Pointer 
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Auto Distribution 
When the Auto Distribution checkbox is checked, the color map is made according to automatic 

distribution between the highest and lowest intensity. Immediately after measurement is complete 

or the file is opened, the Auto Distribution checkbox is always checked. 

 

 

 

 

 

To change the Upper/Lower Value to desired values, uncheck the Auto Distribution checkbox 

and click the Set button. The set upper/lower value settings will be reflected applied to the map 

data color bar. 

 

 

 

 

 

 

 

 

 

  

Click 
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Without interpolation 
 

With interpolation 
 

Displayed in dBuV Displayed in dBm 

Interpolation 
When the Interpolation checkbox is checked, the map data image is smoothly displayed by 

interpolation of the boundaries between divisions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unit 
The unit used to display measured intensity can be selected from dBuV and dBm. 

The change of unit will be applied to the color bar and spectrum graph. 
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Transmittance: 0% 
 

Transmittance: 100% 
 

 

Indication Axis 
Select the desired axis for measurement. 

Intensity distribution map and spectrum graphs are shown according to the selected axis. 

Spectrum graphs for X, Y and Z axes are represented by red, green and blue, respectively. 

 

 

 

 

 

 

 

Transmittance 
The transparency of the color map can be changed. 

When Transmittance is set to 100%, the map is invisible and only the camera image will be 

displayed. When Transmittance is set to 0%, the camera image is invisible at the points where 

data exist. 
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Frequency Range 
If the Specified Frequency checkbox is checked under Frequency Range, the map is 

color-coded not using the peak values of the whole frequency range but using those of the 

specified frequency range, and the relevant blue zone band is displayed in the spectrum graph. 

This zone band can be moved to the right or left by dragging it, and thereby the color-map on the 

camera image changes. In addition, the width of the zone band can be changed by dragging an 

end of the band to the right or left. 

 

 

 

 

 

Clicking the Set button opens the Frequency Setting dialog box, where the frequency range for 

the zone band can be directly entered. 

 

 

 

 

 

Measurement Information 
The measurement date is automatically input in the Day field. For other items, enter information 

freely. If no information is required, leave the field blank. 

 

 

 

 

 

 

Memo 
Any information about measurement can be entered freely. In the Memo field, there is no limit of 

the number of characters. 

 

 

 

Click 
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After matching map view data 
 

Before matching map view data 
 

  

Matching Map View Data 
The same setting can be applied to all maps on the View windows that are currently open. 

When Match Map View Data in the Window menu is clicked, the map view settings of the last 

active View window will be applied to all of open View windows. The settings to be applied include 

Upper/Lower Value, Interpolation, Unit, Indication Axis, and Transmittance. Specified 

Frequency is also applied if the START and STOP frequencies are the same among Windows. 

Use this function to compare measurement data before and after corrective actions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 
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Exporting Measurement Data 
Measurement data can be exported to an external file. 

Select Export from the File menu, and choose one from Map Data, Spectrum Data, and All 

Spectrum Data. The Save As dialog box will appear. 

 

 

 

 

 

 

 

 

 

In Save as type on the Save As dialog box, either CSV File or Bitmap File can be specified. 

 

 

 

 

 

 

 

 

 

 

 

 Map Data 

CSV file: The peak values for each measurement point are exported. 

BMP file: The map data image pasted on the camera image is exported. 

 Spectrum Data 

CSV file: The spectrum waveform data for the point indicated by the pointer    is exported. 

BMP file: The spectrum graph image for the point indicated by the pointer    is exported. 

 All Spectrum Data 

CSV file: The spectrum data for all measurement points are exported. 

 

Click 
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Print 
The measurement conditions, map image, and spectrum graph can be printed. 

Select Print or Print Preview from the File menu or select the Print button on the toolbar. 

 

 

 

 

 

 

 

 

Click 

Click 
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10. Setup 
 

10－1.  Important Notes on Setup 

 
This section describes setup for the software and peripheral devices. To perform setup, you must be 
logged in with administrator privileges. 
Also, it is recommended that setup be performed by some engineer with a certain degree of 
proficiency in computers, including having an understanding of Ethernet addresses and other 
terminology. 
Be aware that some details may vary for different OS versions, PC display settings, and other 
environments. 

 

10－2.  Network Address Settings 

 

1) Setting the IP Address of the PC 

From the Control Panel, select Network and Sharing Center, and click Change adapter 

settings from the list on the left side. 

 
<How to open Control Panel> 
In the search box on the taskbar, type Control Panel, and then select Control Panel. 

 

The adapters that can connect to the network are displayed. Double-click the adapter (local area 

connection) that is connected to the oscilloscope to display its properties. Select "Internet 

Protocol Version 4", and click to display the properties. 

 

 

Enter "192.168.99.3" for the IP address  

and "255.255.255.0" for the subnet mask,  

and click OK. 

This completes the IP address settings  

for the PC. 

 

 

 

 

  

 

2) Setting the IP address of the Oscilloscope 

Start the oscilloscope, and press the SETUP button. 

The SYSTEM screen is displayed. From here, select Network. 

Select Local Area Connection, select Internet Protocol (TCP/IP), and click Properties. 

Set "192.168.99.100" for the IP address, and set "255.255.255.0" for the subnet mask, and then 

click OK. 
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This completes the IP address settings for the oscilloscope. 

When setting the IP address of the oscilloscope, be sure to refer to the oscilloscope instruction 

manual. Also, if the setting procedure is different from that shown here, the procedure shown in 

the oscilloscope instruction manual takes precedence. 

 

10－3.  Installing the Software 

 

1) Installing NI-VISA 

Load the supplied setup media, and open the "NI-VISA" folder. Run Install.exe to start the 

installation process. Then, perform installation by following the instructions from the installer. 

When installing, make sure that the installation items include NI-VISA. 

 

2) Installing the EPS-02EMFv2 Software 

Load the supplied setup media, and open the "EPS-02EMFv2" folder. 

Run EPS-02EMFv2_En.msi to start the installation process. Then, perform installation by 

following the instructions from the installer. 

* If a previous version of EPS-02EMFv2 software is already installed, uninstall it before 

performing the installation. 

 

3) Use of the supplied USB protect key 

The supplied protect key is not required for checking the measurement data. For carrying out a 

measurement by controlling the peripherals, the supplied protect key is required. 

 

It is required to install the driver of the USB protect key before use. The driver file is in “JSP USB” 

folder in the supplied setup media. After you insert the USB protect key into a USB port of the PC 

where EPS-02EMFv2 software in installed, open Device Manager and select “unknown devices” 

or “HardKey” of “other devices” and install the driver. 

 

The program can run a measurement only when the USB protect key is inserted into the PC. The 

USB protect key can be plugged into any USB port. 
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11. Specifications 
 

11－1. Specifications 

 

1) Sensor Measurement Unit (FT3470-91 by Hioki) 

Item Specifications 

Measurement 

frequency 

10 Hz to 400 kHz 

Sensor Loop coil 

Measurement axes X, Y, Z 

Rated magnetic flux 

density 

2 mT 

Measurement mode 

Magnetic flux density: 10 Hz to 400 kHz, 10 Hz to 2 kHz, 2 kHz to 400 

kHz 

Exposure levels: General Public / Occupational 

Measurement range 

Magnetic flux density: 2 μT / 20 μT / 200 μT / 2 mT 

*Rated magnetic flux density: 2 mT 

Exposure level: 20% / 200% 

Measurement units Magnetic flux density: T / Exposure level % 

Display update rate Approx. 250 ms 

Interface USB 1.1 

 

2) Signal Processor (RTO2004-NSL by Rohde & Schwarz) 

 Item Specifications 

Oscilloscope 

Bandwidth 600 MHz 

Sampling rate 10 G samples per second 

ENOB >7 

Rise time 583 ps 

Input sensitivity 1 mV or higher in base unit 

Channel-to-channel isolation >60 dB 

RMS noise floor at 50Ω  280 μV or less at 200 mV (f.s.) 

Trigger jitter 1 ps or less (rms) 

Waveform acquisition rate Max. greater than 1,000,000 

waveforms per second 

FFT calculation unit 

Noise floor -145 dBm/Hz (typical) 

Updating speed Max. greater than 1200 waveforms per 

second (typical) 

* Refer to the manufacturer's website for RTO6. 
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3) Control Software, PC, Camera 

Item Specifications 

Image size 640 × 480 pixels 

Image division size 10, 16, 20, 32, 40, 80, or 160 pixels 

Capturing type Single / Free Run / Peak Hold 

Measurement unit dBuV / dBm 

Indication axis X-axis / Y-axis / Z-axis / XYZ-axis 

Camera image display Still image / Video 

Secondary functions Save / Import / Export / Comment 

Supported OS Windows 10 / 11 

 

11－2. System Requirements 

 
OS : Microsoft Windows 10 (Japanese / English version) 

Microsoft Windows 11 (Japanese / English version) 
CPU : Dual Core 2.4 GHz or faster recommended 

Memory : 8 GB or more recommended 

Storage : 5 GB or more 

Display : 1366 × 768 dots or more 
1920 × 1080 dots recommended 

 
Other requirements: 
 Operation cannot be guaranteed when using online storage or software that uses 

cloud services. 
 2 empty USB ports 

 
* The upgrade version and the secondary license version require a DVD drive for installation. 
* If software with high CPU utilization is running, the operation may become unstable. 
* Refer to the manufacturer's website for the latest operation warranty of each device such as 
camera. 
 
 

11－3. Supported Oscilloscope 

 
Rohde & Schwarz RTO1004-NSL 

RTO2004-NSL 
RTO6 
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12. Warranty 
 

Repair Service Warranty 

 
This repair service warranty applies to the repair services provided for maintaining the designated 
functions and performance of NoiseKen products. 

 
1. Warranty Coverage 

This warranty covers NoiseKen products and their accessories. 
 
2. Technology and Work Fees 

If a breakdown occurs in a NoiseKen product, NoiseKen will provide repair services free 
of charge based on the warranty terms and conditions as long as the warranty period is 
still valid. If the warrant period has expired, the customer will bear the actual costs 
associated with technology and work for the repair. 

 
3. Ownership of Replacement Parts 

The ownership of all defective parts replaced in the course of performing the repair 
belong to NoiseKen. If the repair service fees are borne by the customer, NoiseKen will 
receive the replaced defective parts unless the customer specifically requests otherwise. 

 
4. Limitation of Liability 

If the customer incurs any damages due to the repair service or breakdown of the 
NoiseKen product purchased by the customer, the liability of compensation for damages 
by NoiseKen to the customer is limited to the amount paid by the customer for the 
applicable NoiseKen product or the applicable non-NoiseKen product (product by other 
manufacturer) only if these damages are due to the willful intent or negligence by 
NoiseKen. However, for damages incurred by the customer due to the above-described 
repair service provided by NoiseKen or breakdown of the applicable NoiseKen product, 
under no circumstances will NoiseKen be liable for any loss of potential income occurring 
directly or indirectly or any direct or indirect damages due to compensation by the 
customer to a third party. 

 
5. Wrong Parts, Missing Parts, or Breakage 

If the product cannot be used when a wrong part, missing part, or breakage occurs in a 
NoiseKen product purchased by the customer, NoiseKen will not be liable for any 
damages whatsoever for losses incurred by the customer due to loss of sales or other 
derived losses, special losses, or indirect or punitive damages, or any damages due to 
compensation by the customer to a third party. 

 
6. Decline to Repair 

The company may not accept a repeair order in the following cases. 

・ More than 5 years have passed since manufacture of a product discontinued. 

・ More than 8 years have passed after delivery. 

・ Required component for servicing already discontinued and no alternative is 
avaaiable. 

・ Product changed, repaired or remodeled without obtaining a prior permission from 
the Company. 

・ Product severely damaged to the extent it has lost its original form. 
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Product Warranty 

 
For breakdowns that occur within the product warranty period, NoiseKen will repair or replace the 
product free of charge. The extent and content of the repair work for the equipment will be 
determined by NoiseKen. This product warranty is valid in Japan only. 
 

1. Device Coverage 
This warranty covers NoiseKen products and their accessories. 

 
2. Product Warranty Period 

・ This warranty is for one year starting from the delivery date of the product. 
If the same breakdown at the same location is repaired, the warranty period is six 
months from the date that the repair was completed. 

・ For non-NoiseKen products, the product warranty of the supplier (manufacturer) applies. 

 
3. Exceptions 

Regardless of the above stipulations, the warranty does not cover breakdowns due to one of 
the following. 

 
 Replacement of consumable parts, including the replacement (for used products) of 

mercury relays, high-voltage relays, coaxial cords, coaxial connectors, automatic 
switchers, contactors, and other consumables 

 Damage or breakdowns that occurred due to failure to follow proper operating 
procedures. 

 Product failures resulting from damage or breakdowns due to modifications not 
involving NoiseKen 

 Product failures resulting from damage or breakdowns that occurred when someone 
unauthorized by NoiseKen attempted to perform repairs 

 Product failures resulting from damage or breakdowns caused directly or indirectly by 
natural disasters, war, riots, civil strife, or other force majeure 

 Product failures resulting from damage or breakdowns caused by transportation, 
vibrations, dropping, impact, or other misuse after delivery 

 Product failures resulting from damage or breakdowns caused by the usage 
environment 

 When the customer takes the product outside Japan 
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Software Warranty 
   
A warranty is provided for the software produced by NoiseKen and its update files under the 
following terms and conditions. This warranty is valid in Japan only. 

 
 

1. Scope of Warranty 
This warranty applies to the software produced by NoiseKen and its update files. 

 
2. Free Support 

If a fault occurs in the system as a result of this software by NoiseKen, NoiseKen will 
provide support free of charge through software fixes and updates or other means only 
within the warranty period. However, please be aware that we may discuss when to 
implement corrective measures for minor issues. 

 
3. Total Maximum Liability 

If the customer incurs losses or damages due to a fault of this NoiseKen software 
purchased by the customer, unless the losses or damages are the result of willful or 
negligent actions, the maximum amount of NoiseKen’s liability for compensation for 
these losses or damages to the customer is equal to the amount that the customer paid 
for this NoiseKen software. But, NoiseKen assumes no liability for any losses or 
damages incurred by the customer due to faults arising from this software by NoiseKen, 
including but not limited to, direct or indirect potential lost earnings and direct or indirect 
damages due to third party claims for compensation against the customer. 

 
4. Warranty Period 

The warranty period is the support period of the OS by the provider (including extended 
support periods) for the OS where operation is guaranteed by NoiseKen. When the 
support period of this OS ends, support for this software in this OS will also come to an 
end. 
The after service of the software ends support when the production and sales of the 
specific control equipment are discontinued. 
 

5. Exclusions 
These terms and conditions do not constitute a full and complete guarantee of operation 
or compatibility with the customer’s system. Also, the following situations are outside the 
scope of support. 
[Combining with products] 
Although every effort will be made to provide comprehensive software support, in 
combination with products other than those recommended by NoiseKen, some faults 
may be unable to be resolved due to lack of compatibility or conflicts with PCs, 
peripherals, and other hardware, and OS and other software. In addition, even in 
combination with products recommended by NoiseKen, faults may be unable to be 
resolved due to serious defects occurring in the recommended products. 
[Added functions and OS upgrades] 
Please note that support for added functions and OS upgrades are outside the scope of 
free support. 
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13. NOISE LABORATORY SUPPORT NETWORK 
 

 If a symptom which seems a trouble is found, check the symptom, software version, 

model name of connected device, and serial number, and inform this information to 

Noise Laboratory or your nearest sales agent of Noise Laboratory. 
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